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Conventions

The typographic conventions used in this help are described below.

Convention Description

Bold Used to denote components of the user interface such as buttons,
field names, menus, and menu options.

For example, the New button.
Menu...MenuOption Select the menu from the menu bar then select the menu option
from the menu.

For example, File...Open would mean to select the File menu
and then the Open option.

CAPS Used to denote the name of a key on the keyboard.
For example, the ENTER key.

ltalics Used to denote emphasis, captions and the result of an action in
a procedure.

Technical Support
General enquiries on the QPt should be sent to:

HREM Research Inc.
Email: support@hremresearch.com
Web: www.hremresearch.com

Copyright Statements

© Copyright 2005-2025 HREM Research Inc.
All rights reserved. This manual is protected by international copyright laws
and treaties. Unauthorized reproduction and distribution of this manual, or any

portion of it, will be prosecuted to the maximum extent possible and may result
in severe civil and criminal penalties.

DigitalMicrograph is a trademark of Gatan Inc.

QPt 2



1. Introduction

1.1

The QPt (Quantitative Phase Technology) is a plug-in for use in Gatan’s
DigitalMicrograph of GMS (Gatan Microscopy Suite).

This QPt manual is written to provide information on the basic functions of the
QPt plug-in, a procedure for installation of the Plug-In, and some general tips
on operation. This Guide assumes the user is familiar with image manipulation
using DigitalMicrograph as well as Windows operating system.

How QPt works?

1.2

The QPt takes digital intensity images and processes them to yield the phase of
the object under investigation.

The QPt relies on the Transport of Intensity Equation (TIE) that is a differential
equation between intensity and phase:

d
= 1(xy2) = ~Vy - (1Y) Vay b (x92)

Here, I(xyz) and ¢p(xyz) are the intensity and the phase of the object wave,
respectively, and Vy,, is the two-dimensional gradient operator, say

Viyp(xyz) = (0¢(xyz)/0x, 0¢p(xyz)/0y).

Normally, the QPt uses three images taken with the same defocus step, and
01(xyz)/0dz is approximated with the difference between the intensities of the
first and third images. When we use the second (middle) image as I(xyz), the
TIE becomes an equation for ¢(xyz), the phase of the middle image.

Advantages of Using QPt

No Special Optics Required to observe a Phase Object

Phase imaging with electrons is an advanced research procedure using electron
holography, which requires an electron bi-prism.

Electron holography gives only a mixture of phase and amplitude information
(a complex wave), and requires a certain level of skill to obtain useful images.
Electromagnetic Field Observation (QPt Only)

The QPt includes the functionalities to estimate and analyze magnetic/electric
field from the phase image.
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1.3

(Biological sample) Obtaining Detail without the Use of Stains at Focus

In the case of the biological sample that is a phase object, the use of stains is
necessary to enhance the intensity contrast of an image, which may also change
the nature of the sample being analyzed. Also, some stains need to be handled
with care as they may be toxic.

Alternatively, in the case of the phase object, the image is often taken slightly
out of focus to achieve better contrast and to highlight structures. However, it
inevitably introduces some blur and also artifacts.

Using the QPt, the use of stains is unnecessary, and the retrieved phase image
is sharp, and reflect the sample structure, when the middle image is captured at
the true focus of the sample. If the middle mage is out-of-focus, we can obtain
the image at the just focus by propagating the retrieved complex wave.

Aberration Correction (HREM Module)

The combination of the amplitude and phase information completely defines
the transmitted complex wave field. Therefore, for example, we can propagate
the complex wave to any desired plane.

In electron microscopy, a spherical aberration limits a resolution contrary to
optical microscopy. Obtaining a complex wave, however, we can correct the
spherical aberration and adjust a defocus.

Projects and Images

The QPt provides a routine to acquire a series of the images on-line from an
electron microscope. Or, you can use the images that are already acquired and
saved.

A QPt project is made from three or two images taken from a particular sample
at different image planes. Here, the three images should be taken with the same
defocus step.

Three image case:

Symmetric project: negative defocus, in-focus and positive defocus images.
Asymmetric project: three images taken with the same defocus step. Here, the
center image is not an in-focus image.

Two image case:

Symmetric project: negative defocus, and positive defocus images. The in-
focus image is approximated by the average of the negative and positive
defocus images.

Asymmetric project. two images taken with an arbitrary defocus step. The
center image is approximated by the average of the negative and positive
defocus images.

NOTE: In high resolution electron microscopy (HREM) the center image in
the sequence images may not be literally in-focus. In this case the QPt gives a
phase distribution at the middle plane. The complex wave at the middle plane
can be propagated to the in-focus plane. For more details in atomic resolution
application of the QPt, see HREM Modules.
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2.

Image Alignment

2.1

Image alignment is essential for the phase evaluation using the QPt. This is
because the Transport of Intensity Equation (TIE), on which QPt is based, uses a
difference of the image intensities.

How to Align Images

NOTE:

When the images are captured using an electron microscope or digitized after
image acquisition, various image distortions can occur. Thus, the QPt gives a
variety of alignment procedures as explained below. Before aligning the images,
the images have to be stacked to a Project image using Setup Images....

The QPt gives a variety of procedures for image alignment as listed below:
e  Manual Alignment
e  Affine Alignment
using Mouse Points
using Mesh Positions
using Fourier Spots
e  Segment Alignment
e  Translation Alignment
e  Apply Previous Alignment

Each alignment mode will be explained below one by one.

It is advisable to place the markers (reference points) that tell the alignment
routine the same image points on each image. The marker may be placed by
using HREM Mouse tool, or may be a Line Annotation or Line ROI.

QPt



2.2

Manual Alignment

TIPS:

In some cases, it may be difficult to find distinct small image features. Then, you
may want to use the Manual Alignment. This alignment mode will work even if
an image displacement or an image distortion (scale difference and/or image
rotation) is large,

The figures below show an image alignment window and the Manual Alignment
tool. The Manual alignment tool aligns at each time two images, namely the
Target image with respect to the Reference image, which are chosen by the
image selector (top part) of the alignment tool.

It is advisable to use the most distinct image as the Reference image for the first
alignment. Then, the aligned images will be listed in the Reference image
selection, and the images to be aligned will be listed in the Target image
selection.

[E] Manual Alignment

Current Images

Reference |0 v I

Target 01 v I
otart I OK Cancel

Translation reset |

-

Manual Alignmen

LSk P ¥ 000
- = \sﬁte 000
Z ¥ T~

Scale reset | Step

1 l| 10000 [001
Anele _reset | Step

d N | 000 [1 =
Digplay mode
IDifference L'
CB Size Flash FPS
e [
QK
Image alignment window Manual Alignment tool

You can adjust an image translation, scale and rotation independently. Here, you
can change an alignment step, and cancel each alignment by pressing the reset
button.

If there are noticeable differences in image scales, image rotations, image
displacements, etc., it is recommended to place a Line Annotation (or Line ROI)
that connects the same image features on each image before (or after) setting up
the Project image. Then, this command adjusts a scale and rotation of the image
by using the start and end points of the drawn lines, which should greatly reduce
the amount of manual alignment to be performed by the user.

You can use two HREM Mouse points as the markers instead of the Line
Annotation (or ROI).
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2.3

Display mode

The Manual alignment tool gives a possibility to select a Display mode. Using a
checker board mode, both Reference and Target images can be shown
alternatively. simultaneously, say in checker board style of Using a flashing
mode, the Reference and Target images will be shown in turn.

Image Contrast Adjustment

You may note that the image display mode will not work well, if the contrasts of
two images under alignment show appreciable difference. Therefore, this
alignment mode gives a possibility to adjust a contrast of each stacked images
using Display Adjustment dialog shown below:

Contrast Limits lLocaI Variance ] Mone ]

Remowe Lowest |01 % of outliers
Highest |01 % of outliers

7 Adjust Local Mean |64 v | pix
Check

Please consult Quick Reference Guide for details on how to use this dialog.

In some case, performing the Manual Alignment with high accuracy is not an
easy task. Then, you can perform Affine Alignment, say using Mouse Points, after
rough alignment using the Manual Alignment.

Affine Alignment

TIPS:

This alignment performs Affine Transform by adjusting a scale and rotation angle
as well as image displacement. Here, the Affine transform parameters will be
estimated by cross-correlations of small image areas specified by HREM Mouse
Points or Mesh Positions or Fourier Spots.

Affine Alignment tries to adjust the scale, rotation angle and image
displacement. However, you can fix the scale and/or rotation angle by uncheck
Scaling and/or Rotation of the Option tab, if it is appropriate. Their default
settings are selected (checked) as shown below.

iz Alignment setup =R |

Alignment Option lDispIayl
Affine / Fourier
(V] Scaling
[V]Rotation

[ Final Translation

When you check Final Translation (default setting is unchecked), image
translation is further adjusted using the cross-correlation of the whole image after
Affine transform. Please consult Quick Reference Guide for details on how to
use this dialog.
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2.3.1

137

NOTE:

TIPS:

TIPS:

2.3.2

Affine Alignment using Mouse Points

This alignment mode will work even if an image displacement or an image
distortion is large, when the corresponding image points of each image are
manually specified using the HREM Mouse tool (the fat mouse) before setting
up the project image (with Setup Images).

The image below shows some mouse clicks, each of which defines the center of
small image area to be used for calculating an image cross-correlation.

When you specify the equivalent points on each image, the sequential number of
the mouse clicks should correspond to each other among the images

When an image displacement or an image distortion (scale difference and/or
image rotation) is not large, the mouse points on one of the images will be
applied to other images. Thus, you don’t need to specify the mouse points on all
the images. In this case, the mouse points can be placed on the project image
even after setting up the project image.

How to delete a mouse click: Click a point close to the mouse click to be deleted
with the SHIFT key down. Then, the mouse clicks will be automatically
renumbered.

When you define the reference points using HREM Mouse points or Line
Annotation(s) (or Line ROI), but select None from Cross-Correlation Mode, the
reference points will be simply used for Affine transform without evaluating
cross-correlations.

Affine Alignment using Mesh Positions

In this alignment mode, the image is evenly divided into n x n areas, where n will
be 3, 5, 7 or 9, and the center of each image area defines reference points for
cross-correlation, whose size will be selected from 32/64/128/256/512 in pixels.

When an image displacement or an image distortion is relatively large, however,
this alignment mode will not work. Therefore, the image stack should be
approximately aligned before using this aliment mode.

Furthermore, when some image areas do not show specific features, for example,
correspond to vacuum area, this alignment mode will not give good results. In
such a case, Affine Alignment using Mouse Points will be used.
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2.3.3 Affine Alignment using Fourier Spots

NOTE:

When you want to align atomic resolution images taken from a crystalline
specimen, spot positions of Fourier transform may be used to adjust a scale and
rotation angle. It is noteworthy that the spot positions depend only on the image
periodicities, but not the image contrast. Therefore, the Fourier alignment is
robust against a contrast change due to defocus variation.

It should be noted the displacement of image feature does not change intensity
distribution of Fourier transform. Therefore, after the adjustment of scale and
rotation, this alignment mode performs translation adjustment based on the
cross-correlation of the whole image area as the last step of the alignment.

The Fourier transform can be calculated using the FFT command of the Process
menu or the IPU menu. You can use a Fourier transform of any one of the
images to be aligned.

Some spots that will be used for alignment should be specified by using the
HREM mouse tool as shown in the image below:

On the Scheme of the Alignment tab, you have to select the Reference Image
and the corresponding Fourier Transform from the list of active Fourier
Transforms.

Reference Image:

Fourier Transform:

|G: FFT(untitled) v

Please consult Quick Reference Guide for details on how to use this dialog.

When the image is over sampled, the Fourier spots will not appear so much
away from the origin. Then, the Fourier alignment will not be so accurate. In
such a case, you may want to use Affine Alignment using Mouse
Positions or Mesh Positions after Affine Alignment using Fourier
Spots.

QPt
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2.4

Segment Alignment

NOTE:

2.5

When an image distortion is non-linear and position-dependent, namely not
represented by an Affine transform, you can use Segment Alignment. In this
case the whole image is segmented into many small areas, and each image area
will be displaced by different amounts.

The segment alignment will be essential for the biological sample that is
sensitive to electron beam irradiation. In such a case, an image may be non-
linearly distorted due to specimen degradation.

It is important to note that the images should be well aligned before applying
the segment alignment. Thus, it is recommended to perform Affine
Alignment before Segment Alignment.

Translation Alignment

2.6

With this alignment mode, only an image displacement is adjusted by the cross-
correlation over the whole image areas. Therefore, the scale and orientation of
all images should be well adjusted before this alignment.

If there is no significant distortion, but large image displacement, you can use
firstly Translation Alignment before Segment Alignment or Affine Alignment.

Apply Previous Alignment

This alignment mode aligns the front project image using the same alignment
parameters determined during the previous alignment.

There is the case where good alignment can be achieved using trend-subtracted
images (use Trend Subtract command), or edge-enhanced images (say, obtained
with Sobel Spatial filter, Laplacian filter etc. of the DM Process command) of
the original images. Then, after performing the alignment for the modified
images we can use Apply Previous Alignment to the original images.

QPt
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3. Phase Images

3.1

The QPt phase image contains the refractive information for the sample in a
form that has not been available using any other method. This phase
information is entirely independent of the sample absorption. These
quantitative phase images tend to appear visually fuzzy but the data in them is
more accurate because of the purity of the phase information.

The phase images can be used as they are, or can be used to create magnetic/
electric field images. Furthermore, by creating a complex wave using the
intensity information, we can correct spherical aberration, or to propagate the
complex wave to an arbitrary plane.

High Pass Filter

NOTE:

The high pass filter controls the amount of details that is present in the image.
At a High Pass Filter (HPF) setting of 0, the phase image can be quantitative, if
there is no low frequency noise. As the HPF value is increased the spatial
frequencies are gradually filtered out from the lowest frequency. This has two
consequences: 1) strong low frequency noise is suppressed; but 2) the image
becomes less quantitative. When the HPF values is increased too much, the
image becomes more composed of boundary or edge details.

However, an electron micrograph is normally too noisy, and gives so-
called white noise over the whole frequency of its Fourier transform.
The QPt algorithm tries to retrieve information by dividing the Fourier
transform of image intensity by a squared modulus of frequency. Thus,
the noise at low frequency is apt be amplified and gives a slowly varying
strong background over the entire image. This slowly varying
background easily hides the fine details of the phase distribution.
Therefore, it is advisable to apply the HPF as low as possible to reveal
the fine details of the phase. The following example shows phase
distributions calculated from electron micrographs of magnetic material
by changing the HPF value.

The form of HPF (High Pass Filter) is the Tikhonov filter for 1/q?:

q?/(q* + a*), where q is a frequency in Fourier space, and a is a HPF
constant. The HPF value a is given in pixels in Fourier space. Thus, the HPF
attenuates low frequency components, and passes high frequency components
with less attenuation.

QPt
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Image generated with the High Pass Filter Image generated with the High Pass Filter
setto 0. Fine details of the phase set to 5. The object phase distribution starts

distribution are hidden by slowly to be observed here.
varying strong background.

Image generated with the High Pass Filter Image generated with the High Pass Filter
set to 10. set to 20. The image becomes more composed
of boundary or edge details.

QPt 13



4. Field Filter Images

The phase measured by QPt is a consequence of the electron refractive index of
either the electric field of the specimen material or the magnetic field structure
of the specimen or a combination of both.

Because deflection can be caused by the electric field as well as magnetic field,
non-uniform magnetic sample may include deflections caused by a mixture of
electric field and magnetic field. If the magnetic sample is not uniform, the
phase change due to the electric and magnetic fields should be separated before
applying the field filter. Thus, the field filter gives a magnetic field, only when
the magnetic sample is homogenous and uniform.

The field filter tool quantifies the direction and magnitude of the magnetic/
electric field from the slope of the phase image. Magnetic/Electric Field
command displays the vector field in a RGB color with arrows of various sizes
for a qualitative view, while Magnetic/Electric Field Raw command
creates the complex image that is composed of the x- and y-components of
the field vector for quantitative representation.

RGB color image representation

In the RBG color image, the magnetic/electric field vector is represented
as colors according to the color wheel below, where a direction of the
field vector is color coded, and a magnitude of the field vector is coded
in the brightness of the color.

Color Wheel:
The direction and magnitude of the field
determines the color displayed.

Color Bar (below): The magnitude of the field
determines the color displayed.

Complex image representation

In the complex image display, the x- and y-components of the
magnetic/electric field vector are encoded into real and imaginary parts
of complex image. From the complex image you can create a magnitude
image using Utility -> Complex to Real -> Amplitude. The vector field
coordinates can be rotated, and a magnitude of the vector field along or
perpendicular to the preferred direction can be read easily. See Field
Filter -> Rotate Coordinates.

QPt
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4.1 Field Filter Options

The following examples use the phase image below obtained from of a
magnetic material of uniform thickness.

To see the field filter image (see the left image below), select Field Filter ->
Magnetic Field, when the project image is at frontmost. The direction of the
magnetic field is represented by changes in color as well as the arrows. The
magnitude of the magnetic field is represented by the brightness of the image as
well as the length of the arrows.

To see only the arrows representing the direction and magnitude (the middle
image), click on the Color (On/Off) submenu.

To see only the color and intensity without the arrows (the right image), click
on the Arrows (On/Off) submenu.

The length and spacing of arrows as well as their color can be changed using
the Field Filter Setup dialog of Field Filter.

Field filter image Magnetic field direction Magnetic field direction and
and magnitude represented = magnitude represented by
by arrows directional color

The arrow type can be selected from Two Lines and Filled Triangle.

Two Lines Filled Triangle Filled Triangle (Size:100%)
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To see a color representation of the magnitude of the field without the color-
coded direction, click on the Direction (On/Off) menu. (sce the left image
below)

To overlay the original image on the magnetic field while, click on the Image
Blending (On/Off). (the right image)

You can select an image to be blended and specify the amount of intensity
information in the Field Filter Setup dialog.

Color representation of magnetic field  The magnetic field including
magnitude (Direction: Off) information from the in-focus image
(Blend: On)

4.2 Field Density Map

The field density map (the right image below) is the two-dimensional
histogram of the magnetic/electric field vectors, which gives the two-
dimensional distribution of the field vectors. The number of bins of two-
dimensional histogram can be defined in the Field Density Map dialog. The
intensity can be displayed in gray scale or pseudo-color. You may note that you
can use a rectangular ROI to select the region for the density map.

¥ I: PrCaSrMnO M-Field

Field density map corresponding to the ROI
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5. Knife Edge Images

Knife-edge method (Schlieren method) is a simple method to observe a phase
object. If your sample is a pure phase object, the amplitude of the exit wave
after passing the sample will be constant. Therefore, no image feature will be
observed, when the whole scattering ideally contributes to image formation.
When a knife edge is used to cut out a half of the scattering distribution,
however, even a pure phase object can be observed.

The Knife Edge command emulates the behavior of the knife-edge method in
the microscope. Select Knife Edge when the project image is at the front. Then,
the knife-edge pattern in Fourier space and the corresponding knife-edge image
will be shown. The distance to the Fourier space origin and the angle of the
edge can be adjusted by using the Knife-Edge tab of the QPt tools (see
Command Reference).

The figures below show a knife-edge pattern in Fourier space (top left) and
corresponding knife-edge image (top right). As you can see, the knife-edge
image does not give quantitative information on the sample when compared
with the phase image shown at bottom right.

QPt Tools X

vv Phase Knife Edee Propagatei

Distance to center

U 000 | (] $

Angle
— oo (&[]
| Bright Field -

Remove Knife Edee

[ Done H Cancel }

Knife-edge pattern in Fourier space Knife edge tool
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Knife edge image Phase image
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6. HREM Module (Option)

There is the optional module that is dedicated to high-resolution electron
microscopy (HREM). It has been demonstrated that the QPt can be applicable
even to atomic resolution images taken with a commonly used defocus step:
Phase measurement of atomic resolution image using transport of intensity
equation, Kazuo Ishizuka, Brendan Allman, Journal of Electron Microscopy,
54 (2005) 191-197.

Usually, HREM images are not taken at the in-focus and above and below it,
but taken at the Scherzer (under) focus or further under defocuses. In this case,
we can use a middle defocus image as an in-focus image, and other two
defocus images as under and over defocus images. Then, we can determine the
phase information at the middle plane.

Using the HREM modules a wave field at an exit specimen surface (see Exit
Surface WF-...) or a wave field with a minimum amplitude variation (see
Minimum Amplitude WF...) will be calculated from the wave field at the
middle (in-focus) plane.

Defocus Step

A larger defocus step will give more intensity change, but there is an upper
limit that depends on the resolution you want. The allowable defocus step £/2
for a given resolution g will be given

() T

2 3!
where A is a wave length of electrons. Thus, the allowable defocus step is

inversely proportional to g2 and the wave length A. The following table shows
some defocus distance between an under- and over-focus images (€):

Table: Allowable defocus distance between an under- and over-focus images
for some resolutions and acceleration voltages

1/g 100 kV 200 kv 300 kV
0.14 nm 42 nm 6.2 nm 9.5 nm
0.2 8.4 12.4 19.0
0.3 19.0 28.0 42.7

1 211 311 474
10 211 pm 31.1 pm 474 um
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HPF Setting/Low Frequency Noise

During image formation the low frequency image components will be
attenuated due to phase contrast transfer function (pCTF). Therefore, the QPt
tries to recover these low frequency image components by dividing the
spectrum by the spatial frequency squared. However, at the same time low
frequency noise will be amplified. Therefore, a non-zero high-pass filter (HPF)
setting during the Phase calculation is usually required to suppress low
frequency noise in the phase image. However, a HPF setting as low as possible
should be used when you want to back-propagate a wave-front from a middle
image (in-focus) plane to the specimen exit surface plane. For more
information on the high-pass filter setting, see High Pass Filter section.

Furthermore, some low frequency noise will be reduced by masking low-
frequency components or applying a periodic lattice mask in the case of a
crystal sample. These filtering in Fourier space will be easily performed under
DigitalMicrograph environment.

Example

Here, we will show one example that demonstrates an applicability of the QPt
to atomic resolution images. The image below shows one of the high-resolution
images of SizN4 obtained at NCEM, Berkeley (courtesy of C. Kisielowski).

We may note that this image was taken with a rather large under-focus of about
270 nm, which is a several times of the Scherzer defocus, to extend the spatial
envelope and transfer high-frequency information as much as possible.

The small parts of three images are reproduced below to clarify subtle image
change due to defocus variation of about 12 nm. Here, the left and right images
correspond to an under and over-focus images, respectively, with respect to the
center image.

QPt
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The left image below shows the phase distribution obtained by the QPt using
the whole area of the three images shown above. Here, the HPF setting is zero
(0), and there is the big slowly varying phase change that extends over 55 rad,
and the phase variation (less than half radian) due to atomic structure is hardly
recognized.

The right image shows the reconstructed phase after applying the minimum
HPF, where the phase map becomes almost flat, and an atomic structure can
now be recognized. Here, small round features correspond to atomic columns
of the sample. However, there are unsystematic features of several times of the
atomic feature that come from low-frequency random noise.

It may be noted that the low-frequency noise below the lowest spot from a
periodic structure can be easily eliminated using a low-pass filter. The left
image below shows a small part of the phase distribution that is obtained by
eliminating the low frequency noise. It may be noted that this phase
distribution does not show the expected atomic structure of Si3N4. This is
because this phase distribution corresponds to that at the plane of the center
image, namely about 270 nm under-focus from the sample exit surface.
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We may note that the complex wave at the center image plane can be created
using this phase distribution and the observed image intensity. Then, the
complex wave can be propagated to any image plane. At the same time, we
can correct aberrations of the objective lens including a spherical aberration
(Cs).

The center image above shows the phase distribution at the specimen exit
surface by propagating the wave with the nominal defocus (270 nm under-
focus) and correcting the spherical aberration at the same time. Here, the
atomic structure of the sample (silicon six-membered rings) is clearly observed.

The nominal defocus may not be accurate enough. The right image shows the
phase distribution at the plane where an amplitude variation becomes
minimum. Usually, the phase map at the minimum amplitude demonstrates
more closely the structure model, if the sample is a phase object. Here, the
contrast from even from nitrogen atoms connecting the six membered rings can
be observed.
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Quick Reference Guide
The QPt Main Menuy [FEETST——

Setup Images...

Manual Alignment...
Segment Alignment...
Translation Alignment...

Apply Previous Alignment...
QPt Basic

Phase...

Manual Adjust for Phase...

Generate Complex WF from Project
Band Pass Filter...

Propagate WF 2

Aberration Corrector

Field Filter >

Manual Adjust for Field Filter... QPt

Knife Edge... v

Exit Surface WF... 4 HREM Module
Minimum Amplitude WF... I (Optional)

»d

Check Derivative T
Replace Dud Pixels...
Trend Subtract
Extract Images Utilities
Extract Current Slice

Complex To Real >
Extract Phase image from Project

Shift Wrapped Phase...

Reactivate Reference Point

Help
About QPt
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QPt (QPt Basic)

Acquire Images...

Setup Images...

Manual Alignment...

Segment Alignment...

using Mouse Points...
— using Mesh Positions...

using Fourier Spots...

Translation Alignment...

Apply Previous Alignment...

Phase...

Manual Adjust for Phase...

Generate Complex WF from Project

Band Pass Filter... Manual Defocus...

Propagate WF P — Focal Series...

Aberration Corrector Single Defocus...
Menu Description

Acquire Images...

Acquires three images using a Gatan CCD camera

Setup images...

Creates a project image from archived images

Manual Alignment

Performs alignment of a project image using Manual Alignment
tool. For more information on this alignment procedure, see the
section for Manual Alignment.

Affine Alignment

Performs alignment of a project image based on Affine
transform. In order to determine Affine transform parameters, some
equivalent points on echo image should be specified. The equivalent
points can be given by Mouse Points, or Mesh Positions or Fourier
Spots. For more information on this alignment procedure, see
the section for Affine Alignment.

Segment Alignment

Performs non-liner alignment of a projectimage. For more
information on this alignment procedure, see the section for
Segment Alignment.

Translation Alignment

Performs alignment of a project image by adjusting image
displacement. For more information on this alignment
procedure, see the section for Translation Alignment.

Apply Previous
Alignment

Performs alignment of a project image by applying the same
alignment parameters obtained at the previous alignment. For
more information on this alignment procedure, see the section
for Apply Previous Alignment.

QPt
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Phase...

Generates a phase image using the QPt Tools.

Manual Adjust for
Phase

Adjusts an aligned project image manually and updates the
phase image.

Generate Complex
WF from Project

Generates a complex wave function from the project.

The phase should be estimated before applying this command.
(The project keeps amplitude and phase information.)

Band Pass Filter...

Applies a special Band Pass Filter that passes also the center
beam. Thus,the mean value of the image will be kept
constant.

Propagate WF

Propagates the wave by a specified distance (defocus) or a set of
defocuses. This command is useful, if the center image is not
exactly in-focus. For more information on various procedures,
see the sections for Manual Defocus, Focal Series, Single
Defocus.

Aberration Corrector

Opens Aberration Corrector window (if not opened).
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Acquire Images... Menu

This menu opens the Acquire CTEM Image Series Setup dialog where you can control
image acquisition conditions including a defocus step. When you press 'OK,' three or two
images will be acquired automatically according to the setting at Number of Images.

NOTE: You may have to check an objective lens hysteresis which will affect an actual
defocus value. It is advisable to establish a hysteresis loop and collect images
along the same direction of the loop.

Acquire CTEM Image Series Setup dialog (Control Tab)

¢ Acquire CTEM Image Series Setu

P e

Control I Setup ]
Data Name:
Number of Images:

Focus Step (nm)

Acquisition Focus Offset (nm)
Delay after Focus Change (sec)

Save Option: (@) Save Each Image to Disk

Sample A
N

10
(" Use A Fixed DAC Step

") Create A Stacked Image
(| Convert to Integer 2 Signed

[ OK ][ Cancel ]

The components of the dialog are described below.

Component Description

Control Tab For information about the components of the Control tab,
see Control Tab Below.

Setup Tab For information about the components of the Setup Tab, see
Below.

OK/Cancel Closes the dialog and acquires three images using the
specified parameters, or cancels the command.
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Control Tab

Component

Description

Data Name

Acquired images will be identified with this name, and a
sequential number added after this name.

Number of Images

The number of images to be acquired, which should be three (3)
or two (2).

Focus Step (nm)

Defocus difference between the images (in nm). The defocus
direction is determined by Defocus Range in Setup.

Use a Fixed DAC
Step (nm)

If checked, a constant DAC step will be used, and thus the
defocus step will be fixed.

NOTE: A required DAC to change a specified defocus may not
be an integer value. In this case, an actual defocus is
approximately equal to the specified value, and the defocus
step may not be constant. This setting is useful, if a single DAC
is coarse to realize a specified defocus step.

Acquisition Focus
Offset (nm)

The defocus will be changed by this amount before taking
images.

Delay after Focus
Change

Delay time after changing a defocus (in sec)

Save Each Image to
Disk

Acquired images will be saved onto a hard disk in the folder
specified at Setup tab.

Create a Stacked
Image

(Don't use this selection for QPt)
One stacked image will be created. NOTE: The stack will
not be saved.

Convert to Integer 2
Signed

An acquired image will be saved as Integer 2 signed after
converting from an Integer 4 signed. Use this option only when
your image is known to be expressed as Integer 2 signed.
(These days, an imagewill be acquired and saved as Integer 4
signed, which requires a large memory space.)
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Setup Tab

Control Setup |

Focus Calibration (nm per DAC):

Magnification:

Camera Control:

Folder:  C:¥Users¥hrem¥Desktop¥QPt

[ Browse Folder Directory ]

I 1.0
I 1000.0

Defocus Range: [Under to overfocus

)

@ CM Command

(") S5C/MSC Command
[ OK ] [ Cancel ]
Component Description
Folder Acquired images will be saved into this folder, when 'Save Each

Image to Disk' is selected. You can browse the folder directory.

Focus Calibration
(nm per DAC)

Specifies a focus change in nm for a unit DAC change.
This will be automatically specified, when you have Gatan's
plug-into measure this value.

Magnification

Image magnification (This will be read from your microscope,
if possible.)

Defocus Range

Always use “Under to overfocus”

Camera Control

Selection of camera control protocol from CM commands and
SSC/MSC commands.

QPt

28



Setup Images... Menu

The opened images will be set up into a project image in the order listed in the "Window"
menu. The TOP (FRONT) image should be most UNDER-FOCUS, and the defocus step

should be positive.

NOTE: When you want to align images using a set of mouse clicks, you have to place the

same number of mouse clicks on each image before select this Setup Images

command.

Setup Images dialog (Image Info Tab)

piz Setup images

Image Info I Option ]

Start Defocus: | -2.0

Pixel Size: | 16.5

Acc. Voltage: |300.0

Project Name: | Sample A
Defocus Step: | 2.0 @

["] in-focus image does not show dear features

mm
nm

kv

Source Images: [Three Images v]

[ OK ] [ Cancel

Image Info Tab

Component

Description

Project Name

The images will be set up into a project with this name.

Defocus Step Defocus difference between the images. The defocus step should
be POSITIVE, namely the images should be accumulated from
under- to over-focus. You can choose an input unit from
nm/um/mm.

Mode Specifies the defocus mode from symmetric/asymmetric.

In the case of the symmetric mode, the defocus value of the

center image is assumed to be zero.

In-focus image does
not show clear
features

When checked, the in-focus image will be aligned using the

alignment information between under and over images.

NOTE: When an in-focus image does not show clear image
features, an image alignment may fail. Then, you can use this

option.
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Start Defocus Specified a defocus value of the most under-focused image (the
firstimage in the series).
This box is only available for the asymmetric defocus mode.

Pixel Size An image sampling distance in object space in nm.

Acc. Voltage Specify a high voltage setting (in kV)

Source Images Specifies the number of images to be setup from Three Images
and Two Images (Five Images will be available in future)

Option Tab
iz Setup images <
Image Info Option I
Dud Pixels
V] Quick Dud Pixel Check
Dud Pixel Threshold: | 5.0 Sigma
[ OK ] [ Cancel

Component Description
Phase Unit Unit of phase display is selected from Radian and Wavelength.
Dud Pixels
Quick Dud Pixel When checked, abnormal pixels will be eliminated based on the
Check standard deviation (Sigma) of the whole image.
Dud Pixel Specifies the threshold for a quick dud pixelcheck in standard
Threshold deviation (Sigma).
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Manual Alignment... Menu

The manual alignment will use HREM mouse clicks or a line annotation or line ROI for initial
rough alignment. Then, you can perform fine adjustment manually using the Manual
Alignment Tool explained below.

NOTE: When you want to align images using a set of HREM mouse clicks or a line
annotation or line ROI, you have to place the same number of mouse clicks or a
line annotation or line ROI on each image before select this alignment command.

Display Adjustment Dialog

Manual alignment requires the images normalized between 0 and 1. The normalization
scheme will be selected from Contrast Limit/Local Variance/None using this dialog.

iz Alignment |

Display Adjustment

Contrast Limits ILocaI Variance | None |

Remove Lowest |0.1 % of outliers
Highest |0.1 % of outliers

("] Adjust Local Mean pix

(V| Normalize

[ OK ][ Cancel ]

The components of the dialog are described below.

Component | Description

Image intensity will be adjusted before alignment according to the intensity range
or the range of intensity variance of each image.

Contrast Limits When this tab is selected, image intensity is adjusted
using the contrast limit same as the DM display limits.

Local Variance When this tab is selected, image intensity is adjusted based
on the image variance of each image.

None Tab When this tab is selected, image intensity is not adjusted
Normalize When checked, image intensity is normalized to one afterimage
adjustment.

If you don't want to change the intensity scale, you can disable
the normalization.
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Contrast Limit Mode

Contrast Limits ILocaI Variance ] Mone ]

Remowe Lowest |01 % of outliers
Highest 01 % of outliers

[ Adiust Local Mean |64 v | pix

Check

Component Description

Remove Lowest and Highest define percentages (%) of outliers. The
Lowest outlier pixels will be set to Lowest or Highest values, which
Highest limit the Display range (same as DM display limits).

Adjust Local Mean

When checked, the background is adjusted locally using the
local mean estimated over the square area specified in
pixels. Firstly, the local background is adjusted, and then
outliers will be removed.

Check

Click to check the effect on contrast adjustment.

After removing the outliers, the minimum and maximum intensities will be searched for, and
the image intensity is normalized between 0 and 1 as follows:

X — Xminimum

Xnormalized =

Xmaximum ~— Xminimum

Local Variance Mode

Contrast Limits Local Variance l MNone I

Local Area Size: 64

Display Range: +/- |25 ~| Std

v | pix

Check

Component

Description

Local Area Size

Specifies the size of small square area in pixels, over which a
local mean and variance will be evaluated for each pixel.

Display Range Specifies display range in terms of local standard deviation
(std). Namely, the display range will be +/- *(std) around the
local mean. The intensity outside the range will be clipped.

Check Click to check the effect on contrast adjustment.

After clipping the intensity outside of the Display Range, the minimum and maximum

intensities will be searched for, and the image intensity is normalized between 0 and 1 as

follows:

X = Xminimum

Xnormalized =

Xmaximum — Xminimum
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None Mode

Inage intensity will not be adjusted.

Contrast Limits ] Local Variance MNone

Please note that input images for

Manual Alignment have to be normalized

between Oand 1.

When you select the None tab, image intensity will not be adjusted. The Normalize check box

of Display Adjustment Dialog is a handy option, when the images are not normalized

beforehand.

Manual Alignment Tool

Manual Alignment X

Current Images
Reference |00

Target 01

Manual Alignment

Tranglation reset

RIA(A % om
(] g, O

3N [

Scale Step

(2] 10000

Anele Step

(&%) o[t~

Digplay mode

[OheckerEloard (BAW) v]

CB Size Flash FPS
[ OK ][ Cancel ]
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Current Images Pane.

Component Description

Reference Specifies the Reference Image i.e. the one which will remain
fixed.

Target Specifies the Target Image i.e. the one which will be
shiftedmagnified/rotated to align with Reference image.

Start Starts Manual Alignment with selected images.

OK/ Cancel Applies specified translation, scale and rotation angle to the
target image, or cancels alignment.

Manual Alignment Pane

Component Description
Translation Translates the Target image with respect to the Reference
image, in the direction of the arrow.
Keyboard arrow keys can be used to change four directions
(up/down, right/left). NOTE: If the arrow keys do not work, click
one of the translation arrows once.)
Step Step for one click in pixels.
Scale Magnifies or de-magnifies the Target image with respect to the
Reference image.
Step Step for one click in fractions of scale change.
Angle Rotates the Target image, clockwise or anticlockwise, with
respectto the Reference image.
Step Step for one click in degrees.
Display mode Display mode may be selected from the pull-down list:
Sum (RGB) / Sum (B/W) / Difference / Flash (RGB) / Flash (B/W)
/Checker Board (RGB) / Checker Board (B/W)
CB Size Defines the checker board size (in pixels) for Checker Board
(Checker Board) (CB) display mode.
Flash FPS Defines Image flash rate for Flash mode display.
(Frame Per Second) | (Actual flash rate is hardware dependent.)
Reset Returns the Target image to initial orientation.
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Affine Alignment Menu

Affine Alignment Submenu

using Mouse Points...
using Mesh Positions...

using Fourier Spots...

The options in the Alignment... submenu are described below.

Option Description

using Mouse Points... Starts Affine alignment using HREM Mouse points or the
end points of Line Annotation(s).

using Mesh Positions... | Starts Affine alignment using evenly spaced image positions.

using Fourier Spots... Starts Fourier using some Fourier spots.

The Affine alignment will calculate cross-correlations between the equivalent points or areas
on the images to be aligned. There are three Affine alignment commands depend on the
way to specify the equivalent points or areas on the images. The parameters of Affine
transform will be evaluated from the peak positions of cross-correlations.

using Mouse Points...Submenu

The Affine alignment will use HREM mouse points to indicate the centers of the local areas
to be used for the cross-correlation between the reference and target images.

If the images to be used have appreciable scale and/or rotation differences as well as image
displacement (translation), you have to place the same number of mouse points on each
image before setting up the project using the Setup Images command.

If the images to be used are almost aligned, you need to place the mouse points only on one
of the images. In this case, the same mouse positions will be used for other images.
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Alignment Setup Dialoq (Alignment Tab)

iz Alignment setup

| = |

Alignment lOption ] Display ]

Scheme

Scheme: [Af‘ﬁne

Cyde: |3
Reference Image:

Cross Correlation

Mode: [Square Root Moduli v]

Mask: |0.25

Size: (Affine)

[¥|Hanning Window

[ ok

][ Cancel ]

The components of the dialog are described below.

Component

Description

Alignment Tab

For information about the components of the Alignment tab,
see Alignment Tab Below.

Options Tab For information about the components of the Options tab,
see Option Tab Below.
Display Tab For information about the components of the Display tab,
see Display Tab Below.
OK/Cancel Closes the dialog and opens a dialog to specify the image(s) to

bealigned or cancels alignment.

QPt

36



Alignment Tab

Component

| Description

Scheme Box

Scheme

Alignment Scheme will be selected from:

Affine: Linear alignment (Affine transform) using local cross-
correlations between pre-defined image areas. A single scale
and rotation will be applied over the whole image.

Affine->Segment: After Affine alignment, non-linear Segment
alignment using local cross-correlations between small
segments of the image area will be performed.

Cycle

Maximum number of iterative alignments.

Reference Image

Specifies a reference image for alignment.

Cross-Correlation Box

Mode

Cross-correlation mode will be selected from:
Conventional: cross-correlation using amplitudes.

Square Root Moduli: cross-correlation using square root of
amplitudes.

Phase Only: cross-correlation using unit amplitudes (only
phase will be retained).

None: Mouse points or end points of line(s) will be simply used
for alignment (same as manual alignment).

Size

Cross-correlation size: 32/64/128/Full. In the case of 'Full' any
mouse points or end points of line(s) will be ignored even when
present.

Mask

Specifies a radius of Low-pass filter in Fourier space (relative to
the Nyquist frequency) to reduce high-frequency noise.

Hanning Window

When checked, a Hanning Window will be applied for
Fourier transforms used for cross-correlation calculations.
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Option Tab

iz Alignment setup

Affine / Fourier
(V] Scaling
(V| Rotation

Peak Search

Threshold: |0.5

|| Normalization

Alignment Option |Display]

(| Final Translation

Size: [Z] x2+1 pixels

(| Trend Subtract

[ o

][ Cancel ]

Component |

Description

Affine/Fourier Box

Scaling

When checked, an estimated image scale will be applied.

Rotation

When checked, an estimated image rotation will be applied.

Final Translation

When checked, a translation alignment of the whole image will
be done at the end of alignment.

When an aligned project showsan incorrect translation, you may
want to disable the final translation.

Peak Search Box

Size

Radius of the search are for cross-correlation peak.

Threshold

Intensity below this level will be ignored when searching peak
centers.

Normalization

When checked, image intensity is normalized to unity afterimage
adjustment.

If you don't want to change the intensity scale, you can
disable the normalization.

Trend Subtract

If checked, a trend (slowly varying feature) is subtracted
before alignment to enhance the image feature.
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Display Tab

iz Alignment setup

Alignmentl Option Display |

(| Cross Correlations

|| Difference Image

Message Level:

Component

Description

Cross-Correlation

When checked, cross-correlation patterns will be displayed.

Difference Image

When checked, a difference between under and over focus
images will be displayed. This is useful to check an alignment
quality.

Message Level

Controls the amount of output message to the Results Window.
(None/Normal/Detail)
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using Mesh Positions...Submenu

This Affine alignment will use the evenly distributed n x n points as the centers for the cross-
correlation, where n will be 3/5/7/9.

Alignment Setup Dialog (Alignment Tab)

Alignment setup

Alignment [ReJsiilel)}

Scheme

Mesh Points:
Cycle:
Reference Image:

Cross Correlation

|G Square RootModuli ~

size: (SRR (Afine)
Mask:

Display

Hanning Window

The components of the dialog are described below.

Component

Description

Alignment Tab

For information about the components of the Alignment tab,
see Alignment Tab Below.

Options Tab For information about the components of the Options tab,
see Option Tab Below.
Display Tab For information about the components of the Display tab,
see Display Tab Below.
OK/Cancel Closes the dialog and opens a dialog to specify the image(s) to

bealigned or cancels alignment.
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Alignment Tab

Component | Description
Scheme Box
Scheme Alignment Scheme will be selected from:

Affine: Linear alignment (Affine transform) using local cross-
correlations between pre-defined image areas. A single scale
and rotation will be applied over the whole image.

Affine->Segment: After Affine alignment, non-linear Segment
alignment using local cross-correlations between small
segments of the image area will be performed.

Mesh Positions

Defines the number of evenly spaced positions on the image.

Cycle

Maximum number of iterative alignments.

Reference Image

Specifies a reference image for alignment.

Cross-Correlation Box

Mode

Cross-correlation mode will be selected from:
Conventional: cross-correlation using amplitudes.

Square Root Moduli: cross-correlation using square root of
amplitudes.

Phase Only: cross-correlation using unit amplitudes (only
phase will be retained).

None: Mouse points or end points of line(s) will be simply used
for alignment (same as manual alignment).

Size

Cross-correlation size: 32/64/128/Full. In the case of 'Full' any
mouse points or end points of line(s) will be ignored even when
present.

Mask

Specifies a radius of Low-pass filter in Fourier space (relative to
the Nyquist frequency) to reduce high-frequency noise.

Hanning Window

When checked, a Hanning Window will be applied for
Fourier transforms used for cross-correlation calculations.
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Option Tab

iz Alignment setup

Affine / Fourier
(V] Scaling
(V| Rotation

Peak Search

Threshold: |0.5

|| Normalization

Alignment Option |Display]

(| Final Translation

Size: [Z] x2+1 pixels

(| Trend Subtract

[ o

][ Cancel ]

Component |

Description

Affine/Fourier Box

Scaling

When checked, an estimated image scale will be applied.

Rotation

When checked, an estimated image rotation will be applied.

Final Translation

When checked, a translation alignment of the whole image will
be done at the end of alignment.

When an aligned project showsan incorrect translation, you may
want to disable the final translation.

Peak Search Box

Size

Radius of the search are for cross-correlation peak.

Threshold

Intensity below this level will be ignored when searching peak
centers.

Normalization

When checked, image intensity is normalized to unity afterimage
adjustment.

If you don't want to change the intensity scale, you can
disable the normalization.

Trend Subtract

If checked, a trend (slowly varying feature) is subtracted
before alignment to enhance the image feature.
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Display Tab

iz Alignment setup

Alignmentl Option Display |

(| Cross Correlations

|| Difference Image

Message Level:

Component

Description

Cross-Correlation

When checked, cross-correlation patterns will be displayed.

Difference Image

When checked, a difference between under and over focus
images will be displayed. This is useful to check an alignment
quality.

Message Level

Controls the amount of output message to the Results Window.
(None/Normal/Detail)
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using Fourier Spots... Submenu

The Fourier alignment requires HREM mouse clicks on some spots of the Fourier transform

generated from the reference image. Thus, you have to calculate Fourier transform of the

reference image, and then place some mouse clicks on the spots before selecting this

alignment command.

Alignment Setup Dialog (Alignment Tab)

| & |

Alignment IOption ] Display ]

Scheme

Scheme: [Fourier

Cydle: |3
Reference Image:

Fourier Transform:

[G: FFT(untitted) ~ ]

Cross Correlation

Mode: [Square Root Moduli v]

Size: |64

Mask: |0.25

[¥| Hanning Window

(Affine)

=

H Cancel ]

The components of the dialog are described below.

Component

Description

Alignment Tab

For information about the components of the Alignment tab,
see Alignment Tab Below.

Options Tab For information about the components of the Options tab,
see Option Tab Below.
Display Tab For information about the components of the Display tab,
see Display Tab Below.
OK/Cancel Closes the dialog and opens a dialog to specify the image(s) to

be aligned or cancels alignment.
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Alignment Tab

Component

Description

Scheme Box

Scheme

Alignment Scheme will be selected from:

Fourier: Linear alignment using the specified spot positions of
Fourier transform of the Reference image.

Fourier->Affine: After rough alignment using the specified
spot positions of Fourier transforms, Affine transform in real
space will be performed using local correlations between pre-
defined 3x3 image areas

Cycle

Maximum number of iterative alignments.

Reference Image

Specifies a reference image for alignment.

Fourier Transform

Fourier transform of the Reference Image will be selected from
the image list. This Fourier transform image should have some
mouse points.

Cross-Correlation Box

(Cross-correlation is only effective for Fourier-Affine alignment)

Mode

Cross-correlation mode will be selected from:
Conventional: cross-correlation using amplitudes.

Square Root Moduli: cross-correlation using square root of
amplitudes.

Phase Only: cross-correlation using unit amplitudes (only
phase will be retained).

None: Mouse points or end points of line(s) will be simply
used for alignment (same as manual alignment).

Size

Cross-correlation size: 32/64/128/Full. In the case of 'Full' any
mouse points or end points of line(s) will be ignored even when
present.

Mask

Specifies a radius of Low-pass filter in Fourier space (relative to
the Nyquist frequency) to reduce high-frequency noise.

Hanning Window

When checked, a Hanning Window will be applied for
Fourier transforms used for cross-correlation calculations.
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Option Tab

Affine / Fourier
(V] Scaling

Peak Search

(V| Rotation

Alignment Option |Display]

Final Translation

Size: @ x2+1 pixels
Threshold: |0.5

(V| Normalization

|| Trend Subtract

][ Cancel ]

Component

Description

Affine/Fourier Box

Scaling

When checked, an estimated image scale will be applied.

Rotation

When checked, an estimated image rotation will be applied.

Final Translation

When checked and active, Translation alignment of the whole
image will be done after Affine transformation.

Peak Search Box

Size Radius of search area for the peaks on Fourier transform and/or
the cross-correlation peak.
Threshold Intensity below this level will be ignored when searching peak

centers.

Normalization

When checked, image intensity is normalized to unity afterimage
adjustment.

If you don't want to change the intensity scale, you can disable
the normalization.

Trend Subtract

If checked, a trend (slowly varying feature) is subtracted before
alignment to enhance the image feature.
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Display Tab

iz Alignment setup

Alignmentl Option Display I

|| Cross Correlations

|| Difference Image

Component

Description

Cross-Correlation

When checked, cross-correlation patterns will be displayed.

Difference Image

When checked, a difference between under and over focus
images will be displayed. This is useful to check an alignment
quality.

Message Level

Controls the amount of output message to the Results Window.
(None/Normal/Detail)
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Segment Alignment... Menu

This is non-linear position-dependent alignment, where the whole image is segmented into
many small areas, and each image area will be displaced with different amounts. Before
applying this alignment, the images should be well aligned with Manual or Affine alignment.

Alignment Setup Dialog (Alignment tab)

A =)

Alignment I Option | Display |

Scheme
Scheme:
Cyde: ["_
Reference Image:

Correlation

Mode:

[ OK ][ Cancel ]

The components of the dialog are described below.

Component Description

Alignment Tab For information about the components of the Alignment tab,
see Alignment Tab Below.

Options Tab For information about the components of the Options tab,
see Option Tab Below.

Display Tab For information about the components of the Display tab,
see Display Tab Below.

OK/Cancel Closes the dialog and opens a dialog to specify the image(s)
to bealigned or cancels alignment.

Alignment Tab

Component | Description
Scheme Box
Scheme Segment: non-linear alignment using local correlations

between small segmented image areas.

Reference Image | Specifies a reference image for alignment.
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Option Tab

T

Alignment Option l Display |
Affine / Fourier
Scaling

Rotation
Peak Search

Threshold: | 0.5

[V] Normalization

Final Translation

Size: |5 x2+1 pixels

Trend Subtract

| oK

H Cancel J

Component

Description

Normalization

When checked, image intensity is normalized to unity afterimage
adjustment.

If you don't want to change the intensity scale, you can

disable the normalization.

Display Tab

i Alignment setup

Alignment| Option Display I

(| Cross Correlations

|| Difference Image

Message Level:

Component

Description

Cross-Correlation

When checked, cross-correlation patterns will be displayed.

Difference Image

When checked, a difference between under and over focus
images will be displayed. This is useful to check an alignment
quality.

Message Level

Controls the amount of output message to the Results Window.
(None/Normal/Detail)
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Translation Alignment... Menu

NOTE: The mouse clicks or a line annotation (or line ROI) will be ignored, even when they

exist.

Alignment Setup Dialoqg (Alignment Tab)

iz Alignment setup

<

Alignment I Option I Display l

Scheme

Cyde: |3
Reference Image:

Cross Correlation

schne

Mode: [Square Root Moduli

Size: |64 (Affine)
Mask: |0.25
[¥|Hanning Window
[ OK ][ Cancel ]

The components of the dialog are described below.

Component

Description

Alignment Tab

For information about the components of the Alignment tab,
see Alignment Tab Below.

Options Tab For information about the components of the Options tab,
see Option Tab Below.
Display Tab For information about the components of the Display tab,
see Display Tab Below.
OK/Cancel Closes the dialog and opens a dialog to specify the image(s) to

bealigned or cancels alignment.
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Alignment Tab

Component Description
Scheme Box
Scheme Translation: only translation will be applied.

Reference Image

Specifies a reference image for alignment.

Cross-Correlation Box

Mode

Cross-correlation mode will be selected from:
Conventional: cross-correlation using amplitudes.

Square Root Moduli: cross-correlation using square root of
amplitudes.

Phase Only: cross-correlation using unit amplitudes (only phase
will be retained).

None: Mouse points or end points of line(s) will be simply used for|
alignment (same as manual alignment).

Mask

Specifies a radius of Low-pass filter in Fourier space (relative to
theNyquest frequency) to reduce high-frequency noise.

Hanning Window

When checked, a Hanning Window will be applied for
Fourier transforms used for cross-correlation calculations.

Option Tab

iz Alignment setup

Affine / Fo
ATTINE J o

urier
S‘I&\H‘\g

Rotation

Peak Search

Threshold: |0.5

Alignment Option lDispIay]

Final Translation

Size: E] x2+1 pixels

(V| Normalization

(| Trend Subtract

OK

] [ Cancel
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Component |

Description

Peak Search Box

Size

Radius of the search are for cross-correlation peak.

Threshold

Intensity below this level will be ignored when searching a
peak.

Normalization

When checked, image intensity is normalized to unity afterimage
adjustment.

If you don't want to change the intensity scale, you can
disable the normalization.

Trend Subtract

If checked, a trend (slowly varying feature) is subtracted
before alignment to enhance the image feature.

Display Tab

i Alignment setup

Alignment | Option Display |

[ Cross Correlations

[V| Difference Image

Message Level: | Minimum v

Component

Description

Cross-Correlation

When checked, cross-correlation patterns will be displayed.

Difference Image

When checked, a difference between under and over focus
images will be displayed. This is useful to check an alignment
quality.

Message Level

Controls the amount of output message to the Results Window.
(None/Normal/Detail)
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Apply Previous Alignment... Menu

NOTE: Even when the mouse clicks or a line annotation (or line ROI) exists on the image
to be aligned, they will be ignored for this alignment.,

Alignment Setup Dialog (Alignment tab)

S | —

Alignment ]Optjon I Display I

Scheme

Scheme: [Use Previous Alignment v]

Cyde: |3

Reference Image:

Aligned Project: [0: Sample A_Aligned ¥

Cross Correlation

Mode: |Square Root Moduli

Size: |64 (Affine)

Mask: | 0.25

Hanning Window

[ OK ][ Cancel ]

The components of the dialog are described below.

Component Description

Alignment Tab For information about the components of the Alignment tab,
see Alignment Tab Below.

Options Tab For information about the components of the Options tab,
see Option Tab Below.

Display Tab For information about the components of the Display tab,
see Display Tab Below.

OK/Cancel Closes the dialog and opens a dialog to specify the image(s) to
bealigned or cancels alignment.
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Alignment Tab

Component Description
Scheme Box
Scheme Use Previous Alignment. Alignment information of previously

aligned project will be applied.

In this case, the aligned project should be derived from the
same original images to be aligned. This alignment mode is
useful, when the derived images, such as edge-enhanced
images, give good alignment.

Aligned Project

Aligned project will be selected from the image list.

Option Tab

e s E8

Alignment Option IDisplayI
Affine / Fourier
Scaling
Rotation

Final Translation

Peak Search

oIz

Size: |5 x2+1 pixels
Threshold: | 0.5

[¥] Normalization

Trend Subtract

OK ] [ Cancel

Component

Description

Normalization

When checked, image intensity is normalized to unity afterimage
adjustment.

If you don't want to change the intensity scale, you can

disable the normalization.
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Display Tab

i Alignment setup | %

Alignmentl Option Display I

|| Cross Correlations

|| Difference Image

Message Level: |Minimum v

Component Description

Difference Image When checked, a difference between under and over focus
images will be displayed. This is useful to check an alignment
quality.

Message Level Controls the amount of output message to the Results Window.
(None/Normal/Detail)
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Phase... Menu

Selecting this menu opens the QPt tool that calculate the phase images. Before
selecting this menu, the front image should be an aligned project image.

The phase image will be displayed in a new window, when you click ‘Done’ at the

bottom of this tool.

Phase Tool

QPt Tools

| Phase ‘:Knife Edee I Propagatei

High Pass Filter

D 200

V] Auto Survey

X

&t 4

[ Done ][ Cancel ]

Component

Description

High Pass Filter

The value of the high pass filter (HPF) in the box can be
adjusted by the slider or the up/down arrows,

Alternatively, you can directly input a number in the box. In this
case, you can specify a non-integer number.

Auto Survey When checked, Auto Survey to the Phase image will be
activated.

Done Creates the phase image according to the specified parameters.

Cancel Cancels the procedure.
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Manual Adjust

for Phase...Menu

You can finely adjust an aligned project manually by directly observing the changes of the

phase map.This command uses the same tool for Manual Alignment.

Manual Adjust Tool (Manual Adjust Tab)

Manual Alignment

Current Images

| Manual Adjust '

Tranglation reset

RIRIA % o
(] Y, O

SN [

Scale Step

(#(¥| 10000

fAnele Step

& o[t~

Display mode

[OheckerBoard (BAW) v]

CB Size Flash FPS
[ OK ][ Cancel

)

The relative displacement and/or rotation of the under-focus image (Target) with respect to
the over-focus image (Reference) are manually adjusted as a final tuning of the phase map.

The components of the M
components are identical

anual Adjust Tab are described below. You may note that the
with the Manual Alignment Tool.

Component Description

Translation Translates the under-focus (Target) image with respect to the
over-focus (Reference) image, in the direction of the arrow.
Keyboard arrow keys can be used to change four directions
(up/down, right/left). NOTE: If the arrow keys do not work, click
one of the translation arrows once.).

Step Step for one click in pixels.

Scale Magnifies, or de-magnifies, the under-focus (Target) image with

respect to the over-focus (Reference) image.

QPt

57



Step

Step for one click in fractions of scale change.

Angle Rotates the under-focus (Target image), clockwise or

anticlockwise, with respect to the over-focus (Reference) image.
Step Step for one click in degrees.

Display mode Display mode may be selected from the pull-down list:
Sum (RGB) / Sum (B/W) / Difference / Flash (RGB) / Flash (B/W)
/Checker Board (RGB) / Checker Board (B/W)

CB Size Defines the checker board size (in pixels) for Checker Board

(Checker Board) (CB) display mode.

Flash FPS Defines Image flash rate for Flash mode display.

(Frame Per Second)

(Actual flash rate is hardware dependent.)

Reset Returns the project image to initial orientation.
OK Creates a re-adjusted project image and regenerate a phase
image.
Cancel Cancels the procedure.
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Band Pass Filter...Menu

This is a special Band Pass Filter that passes also the center beam. Thus, the mean value
ofthe image will be kept constant. (NOTE: Bandpass Mask tool of DM cuts the low
frequency including the center beam, thus the mean value of the filtered image becomes

zero.)

How to use:
1. Select a project or image
2. Choose the command (Band Pass Filter)
3. Input the smoothing edge size of the band-pass filter in pixels as shown below:

v DigitalMicrograph ' X

Smooth Edge By(pixels)

|5.0

{ OK H Cancel ’

The filter edge will be smoothed as exp(-(Distance/Edge)**4), where Edge is the Smooth
Edge size and Distance is the distance from the edge.

If you press OK, then the Fourier transform of the image with the band-pass mask and
the control dialog appear as shown below:

. r
iz N: FFT_untitled Phase_HPF 5 =) 2
- (=1 | >SS

Adjust the the band pass filter (low and high frequencies) and Press
<Apply >, or you can abort the command by pressing <Cancel>.

Apply H Cancel J

4. Adjust the size of Band-pass Mask on the Fourier transform in the same way of using
the Bandpass mask of the DM, and then select Apply in the control dialog.
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Propagate WF... Menu

Using this menu, you can propagates the wave function (WF) manually, by a specified
distance (defocus) or a set of distances (defocuses). This command is useful, if the center
image is not exactly in-focus.

Propagate WF Submenu Manual Defocus..

Focal Series...
Single Defocus...

Manual Defocus

You can propagate the wave manually using an interactive
tool:Propagate tab of the QPt Tools.

Focal Series

Waves at a series of defocuses will be calculated.

Single Defocus

The wave at the specified defocus will be calculated.

Manual Defocus Submenu

Manual Defocus tool (Propagate Tab)

QPt Tools

X

Phase [ Knife Edee Propagate

Defocus Step  Unit
00 (T [m -
Cutoff {Aperture)

100000 1/nm

High Pass Filter

D 1.00

bt

[ Done ][ Cancel ]
Component Description
Defocus Distance of wave propagation (defocus) in the specified unit.
You can directly specify the defocus in the box. A negativevalue
corresponds to back-propagation.
Alternatively, you can use up/down arrows to change the defocus.
Step The defocus step for the up/down arrows.
Unit Defocus unit (hm/um/mm)
Cutoff (Aperture) Aperture radius in Fourier space (in 1/nm) to remove high-

frequency noise.

High Pass Filter

Input the value of the high pass filter (HPF) in pixels of Fourier
space. Alternatively, HPF can be adjusted by using the slider
or the up/down arrows,
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Done Creates the last propagated WF in a new image window..

Cancel Cancels the procedure.

Focal Series Submenu

A set of defocused images (focal-series images) will be calculated and saved into a stacked
image.

Focal Series dialog (Control Tab)

g&eries L

Control IDispIay I

Start Defocus: W nm

Last Defocus: W nm

Defocus Step: W nm

Cutoff (Aperture): W 1/nm
HeF: [20

[ OK H Cancel ]

Control Tab
Component Description

Start Defocus Specify the start defocus in the unit of original images.

Last Defocus Specify the last defocus in the unit of original images.
Defocus Step Specify the defocus step in the unit of original images.

Cutoff (Aperture) Aperture radius in Fourier space (in 1/nm) to remove high-
frequency noise.

HPF Input the value of the high pass filter (HPF) in pixels of Fourier
space.

Display Tab

S

Control Display ]

Message Level:

Component Description

Message Level Controls the amount of output message to the Result Window.
(None/Normal/Detail)
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Single Defocus Submenu

Single Defocus dialog

i~ Propagate WF

| & |

Control I Display I

Defocus: |100.0 nm
Cutoff (Aperture): | 10.0 1/nm

HeF: [2
[ OK ] [ Cancel ]
Control Tab
Component Description
Defocus Distance of wave propagation (defocus) in the specified unit. A
negativevalue corresponds to back-propagation.
Cutoff (Aperture) Aperture radius in Fourier space (in 1/nm) to remove high-
frequency noise.
HPF Input the value of the high pass filter (HPF) in pixels of Fourier
space.
Display Tab
| 2 ]

Control Display l

Message Level:

Component

Description

Message Level

Controls the amount of output message to the Result Window.
(None/Normal/Detail)
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Aberration Corrector ... Menu

This command opens Aberration Corrector window (if not opened).The aberration
corrector becomes active, only when the Rectangle ROl is placed on the image.
Aberration correction is applied on the fly to the image within the ROI. The same
aberration will be applied to the wholeimage, when the Apply button is pressed.

Definition of the aberration coefficients: A pre-factor of 1/(n+1) is applied to the Modulus of
n-thorder aberration coefficient. For example, for the second order Coma (B2) the actual

modulusis Modules/(2+1).

Aberration Corrector tool

The components of the window are described below.

Component Description

Rotation Tab Rotational aberrations, namely defocus, and 3rd and fifth
order spherical aberrations. See Rotation Tab below.

Basic Tab Basic non-rotational aberrations, namely two-fold
astigmatism, coma and three-fold astigmatism. See Basic
Tab below.

3rd-order Tab Third order (non-rotational) aberrations. See BasicTab
below how to adjust the parameters.

4th-order Tab Forth order (non-rotational) aberrations. See BasicTab
below how to adjust the parameters.

5th-order Tab Fifth order (non-rotational) aberrations. See BasicTab below
how to adjust the parameters.

Display Selection the display mode from
Imaginary/Real/Modulus/Log of Modulus/Phase.

PCTF Button Phase Contrast Transfer Function (Imaginary part of the
aberration function) will be displayed in a separate PCTF
window. The image size will be specified in the Show PCTF
dialog.

Apply Aberration correction with the current selections will be
applied to the whole image, and the result will be displayed
in a new window..
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Rotation Tab
Rotational aberrations, namely defocus (C1), 3rd order

i X
Aberration Corrector spherical aberration (C3) and fifth order spherical
ard | 4th | 5th aberration (C5), will be adjusted by a value shown in the
Rotation | Basic Value box.
You can input directly a number in the Value box, or
Helta adjust it using the up/down triangles with a step in the
[0 :HI nm Step box.
C1(z)
|U :HI mm
C3(Cs)

|U :”I— mm
Ch

Display: ’Modulus

Basic Tab
) Basic non-rotational aberrations, namely two-fold
Aberration Corrector x astigmatism (A1), coma (B2) and three-fold astigmatism
d | #h | Sth (A2), will be adjusted.
Rotation Basic . . . .
The Modulus will be specified directly in the Value box, or
Modulus(nm)  Anele(dee) adjusted using the up/down triangles with a step in the
Value  Step Step box.
m = g, =
= \ 'L,«J | The Angle will be specified directly within the circle, or
A1(2-fold Astiema) adjusted using the up/down triangles.
= =
o q » =
B2(Coma) -
= s
o= (0 » =
A2(3-fold Astigma) —
Display: IModqus

3rd, 4th and 5th Tabs

You can adjust the higher-order aberrations in the same way as you adjust the above Basic
Aberrations.
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QPt Only

Field Filter » T—®  Maenetic Field
Manual Adjust for Field Filter.. Magnetic Field Raw
fnife Edee.. Electric Field

Electric Field Raw

Field Density Map..
Rotate Coordinates...

Color{On/Off)
Direction(On/Off)
Arrows{On/Off)
Blend(On/Off)

Color Wheel...
Color Bar...

Setup...

Menu Description

Field Filter Creates Magnetic/Electric Field Images. For more information
on various options of the field filter image, see each sub-menu:
Magnetic/Electric Field (Raw), Field Density Map, Rotate

Coordinate.
Manual Adjust for Adjusts an aligned project image manually and updates the
Field Fitter. .. phase and/or field filter image.
Knife Edge... Displays a knife-edge image (Schlieren image). For more

information on the knife edge image, see Knife Edge Image
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Field Filter Submenu Magnetic Field

Maenetic Field Raw

Electric Field
Electric Field Raw

Field Density Map..
Rotate Coordinates...

Color{On/Off)
Direction{On/Off)
Arrows(On/Off)
Blend{On/Off)

Color Wheel...
Color Bar...

Setup...

Submenu

Description

Magnetic/Electric
Field

The magnetic/electric field image will be calculated from the
project image, for which the phase has been already
calculated. Here, thevector field is RGB color-coded with
arrows showing the vector direction and magnitude.

You can change appearance of the vectorfield image using
Setup dialog.

Magnetic/Electric
Field Raw

Two (x and y) components of the magnetic/electric vector field
arecoded into real and imaginary parts of complex image. Thus,
youcan quantitatively analyze the field vector.

Field Density Map...

Displays a two-dimensional histogram of magnetic/electric
field vectors. You can change appearance of the field density
map using Field Density Map dialog.

Before selecting this menu, the front image should be a
magnetic/electric field image.

Rotate Coordinates...

Rotates the x-direction (preferred direction) of the vector field
coordinate.

Display Control

Color (On/Off)
Direction (On/Off)
Arrows (On/Off)
Blend (On/Off)

Toggles color display of the vector field.
Toggles the directional display of the color map.
Toggles displaying arrows.

Toggles image blending.

Color Wheel/Bar...

Shows a color wheel or bar.

Setup...

Opens the Field Filter Setup dialog where you can control an
arrow display and an image blending. For more information
see Setup submenu
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Field Density Map... Submenu

Field Density Map dialog

ity ... |28

Image Size: | 512

(V] Pseudo-Color

(V] Show Color Wheel
Image Size: | 256

(V| Exdude edge region
Edge Width: [T

[ OK ] [ Cancel ]
Component Description
Image size Size of the field density map in pixel.

Pseudo-Color

When checked, the field density map is displayed in pseudo-
color. (When unchecked, the field density map is displayed in
gray-scale.)

Show Color Wheel

When checked, an RGB color wheel will be displayed in the
separatewindow of the specified size.

Exclude edge region

When checked, the border area with the specified width will not
be included in the histogram.

NOTE: In many cases, the border area is contaminated with the
FFT artifacts.

Rotate Coordinates... Submenu

Rotates the x-direction (preferred direction) of the vector field to the specified angle from the

horizontal direction.

The magnitude of the vector field along or perpendicular to the preferred direction can be read

easily from the x and y component images or from the real or imaginary part of the complex image.

Rotate Coordinates Dialog

X-Direction [43.6

Display Mode

@ XY component
Complex image

[ OK ] [ Cancel
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Component Description

X-Direction Specifies the x-direction (preferred direction) of the vector
coordinates. You can directly put a value to the box, or use a line
ROl to specify the direction.

Display Mode X, Y component. Two images will be created for Xand Y
components.
Complex image: A single complex image will be created.

OK Creates a new vector field in the rotated coordinates.

Cancel Cancels the procedure.

Display Control Submenus

Submenu Description

Color (On/Off) Toggles color display

Direction (On/Off) Toggles displaying direction information.

Arrows (On/Off) Toggles displaying arrows showing a magnitude and direction.

An interval, length and color of the arrow will be controlled by
the Setup submenu.

Blend (On/Off)

Toggles image blending. An image to be blended and its blend
ratio will be controlled by the Setup submenu.

Color Wheel.../Color Bar... Submenu
Submenu Description
Color Wheel Creates a color wheel used to display a direction and
magnitude ofthe Vector map.
Color bar Creates a color bar used display a magnitude of the Vector map.
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Setup... Submenu

You can control the properties of arrow display and an image blending for the field filter image
display.

Field Filter Setup dialog (Arrow tab)

Field Filter Setup

Arrow :{[ENT]

Interval:
Length:
Width:

Arrowhead

1878 Two Lines

X Interval

pixels

pixels

v

Angle: deg.(Max: 90 deg.)
Size: % of arrow-length

B Minimum:
B Maximum:

Color: R% GM% BM%

Arrow Tab
Component Description
Interval Specifies an interval to draw arrows (in pixel)
Length Specifies an arrow length in terms of Interval, namely an
actual arrow length is determined by multiplying with Interval.
Width Specifies a thickness of the arrow bar (in pixel)

Arrowhead box

Type Arrow type selection from Two Lines and Filled Triangle.

Angle Specifies a full angle of arrowhead (in degree).

Size Specifies an arrowhead size as a fraction (%) of the total arrow
length. When this Size is set to 100%, a small arrowhead angle
is preferable. In this case, the Minimum and Maximum settings
will be disabled.

Minimum If checked, the minimum arrowhead size (in pixel) will be

applied. This setting prevents the arrows from becoming too
small. When the arrow length itself becomes smaller than this
minimum value, however, an arrowhead size will be set to the
arrow length.
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Maximum If checked, the maximum arrowhead size (in pixel) will be
applied. This setting prevents the arrows from becoming too
large.

Color Specifies an arrow color in RGB.
Blend Tab
pi Field Filter Setup x|
Arrow Blend I
Blend Image:
Blend Ratio: | 20.0 %
V| Apply Blending
Contrast Limits
Low |0.00290% Est.Min 0
["|Remove |2.0 % ofoutliers
High |8.6199  Est. Max 9.68529
["]Remove |2.0 % ofoutliers
[ OK ] [ Cancel ]
Component Description
Blend Image Select a blend image from the sequence number of the images.

Blend Ratio

Specifies a blending ratio.

Apply Blending

When checked, the selected image will be blended.

Contrast Limits box

Low and High

The display limits of the field magnitude in RBG color will be
specified here.

The minimum and maximum field magnitudes are indicated
for your reference. This is especially useful, if there are some
abnormal points (outliers).

Remove outliers

When checked, the display limits are determined by excluding
the high and low outliers of specified amounts.
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Manual Adjust for Field Filter... Menu

You can finely adjust an aligned project manually by directly observing the changes of the
phase and/or field filter map.This command uses the same tool for Manual Alignment.

Manual Adjust Dialog
- Manual Adjust | 2% | Component | Description
Select the images to be updated: Phase Image | Tick to update a phase image.

-
S Phiase Image Field Image Tick to update a Field filter image.

(V| Field Image

[ oK ] [ ol ] The selection(s) may be grayed out, when the phase or
the field map is not created previously for the project.

Manual Adjust Tool (Manual Adjust Tab)

Manual Alignment X

Current Images

Manual Adjust

Translation

LG P T
] g, O

I8N o

Scale Step

§ o8 SRR

Anele Step

(&%) o[t~

Display mode

[CheckerBoard (BAW) v]

CB Size Flash FPS
[ OK ][ Cancel ]

The relative displacement and/or rotation of the under-focus image (Target) with respect to
the over-focus image (Reference) are manually adjusted as a final tuning of the phase and/or
field map.
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Component Description
Translation Translates the under-focus (Target) image with respect to the
over-focus (Reference) image, in the direction of the arrow.
Keyboard arrow keys can be used to change four directions
(up/down, right/left). NOTE: If the arrow keys do not work, click
one of the translation arrows once.).
Step Step for one click in pixels.
Scale Magnifies, or de-magnifies, the under-focus (Target) image with
respect to the over-focus (Reference) image.
Step Step for one click in fractions of scale change.
Angle Rotates the under-focus (Target) image, clockwise or
anticlockwise, with respect to the over-focus (Reference) image.
Step Step for one click in degrees.
Display mode Display mode may be selected from the pull-down list:
Sum (RGB) / Sum (B/W) / Difference / Flash (RGB) / Flash (B/W)
/Checker Board (RGB) / Checker Board (B/W)
CB Size Defines the checker board size (in pixels) for Checker Board
(Checker Board) (CB) display mode.
Flash FPS Defines Image flash rate for Flash mode display.
(Frame Per Second) | (Actual flash rate is hardware dependent.)
Reset Returns the project image to initial orientation.
OK Creates a re-adjusted project image and re-generate a phase
and/or field image.
Cancel Cancels the procedure.
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Knife Edge... Menu

Using this command, you can emulate a knife-edge image (Schlieren image) by manually
controlling the knife edge positionby using the Knife Edge tool.

Knife Edge Tool

QPt Tools

Phasej Knife Edee Propagate:

Distance to center

[ 00 (4§

ngke
U— o0 (&S]
| Bright Field v |

"] Remove Knife Edee

X

[ Done ][ Cancel ]

Component

Description

Distance to center

The distance of the knife edge (in pixels) from center of the
Fourier transform of the image.

This value can be adjusted by using the up/down arrows.
Alternatively, you can directly input a number in the box.

Angle The angle of the knife edge (+/-90 deg) in Fourier space.
This value can be adjusted by using the clockwise/anti-clockwise
rotation icons. Alternatively, you can directly input a number in
the box.

Bright/Dark Field The knife edge will be inverted (the knife edge is rotated by 180

degrees at the Fourier space center).

Remove Knife Edge

Tick to remove the knife edge in Fourier space.

Done Creates the knife edge image.
Cancel Cancels the procedure.
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Exit Surface WF...
Minimum Amplitude WF.

HREM Module (Optional)

Menu

Description

Exit Surface WF...

Opens the Exit Surface WF dialog where you can control the
calculation. When you press 'OK,' a wave function at the
specimen exit surface will be calculated. At the same time, a
spherical aberration (Cs) as well as spatial and temporal
dumping effects will be corrected.

Minimum
AmplitudeWF...

Opens the Minimum Amplitude WF dialog where you can
control the calculation. When you press 'OK,' the wave function
that shows minimum amplitude will be displayed.

Exit Surface WF... Menu

Exit Surface WF dialog

Control I Display |

Cs: |0
Defocus: W
(V| Defocus Spread: |4.

Beam Convergence: | 0.2 mrad

B mm
nm
0 nm

Cutoff (Aperture): | 12.0 1/nm
Noise Control: |0.1
[ OK ] [ Cancel ]
Control Tab
Component Description
Cs Spherical aberration coefficient (in mm)
Defocus Defocus value of the middle (in-focus) image (in nm) from the

specimen exit surface.

Defocus Spread

When checked, the defocus spread specified in the box (in nm)
will be corrected.

Beam Convergence

Incident beam semi-convergence (divergence) angle in mrad.

NOTE: The spatial frequency in Fourier space corresponds to
[semi-convergence angle / wave length] (in 1/nm).
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Cutoff (Aperture)

Aperture radius in Fourier space (in 1/nm) to eliminate high-
frequency noise.

Noise Control

Noise magnitude used in a Wiener type Filter

Display Tab

ri Exit Surface

Control Display |

Message Level:

Component

Description

Message Level

Controls the amount of output message to the Result Window.
(None/Normal/Detail)

Minimum Amplitude WF... Menu

v Minimum Amplitude WF (S|

Control I Display I

Last Defocus: | i

Start Defocus: |-50.0 nm

Defocus Step: | 2.0 nm
Cutoff (Aperture): | 12.0 1/nm

nm

[ OK ][ Cancel ]

Minimum Amplitude WF dialog

Control Tab
Component Description
Start Defocus Start defocus of the defocus range to be searched for a minimum

amplitude.

Last Defocus

Last defocus of the defocus range to be searched for a minimum
amplitude.

Defocus Step

Defocus step of the defocus range to be searched for a minimum
amplitude.
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Display Tab

Control Display I
Result Log

(V] Amplitude Std
Phase Std

Message Level:

[ OK ] [ Cancel ]

Component Description

Result Log When checked, complex wave functions at all the defocuses will
besaved into a stacked image.

Amplitude Std When checked, Std (standard deviation) of the amplitude
distribution at each defocus will bedisplayed in line plot.

Phase Std When checked, Std of the phase distribution at each defocus
will bedisplayed in line plot.

Message Level Controls the amount of output message to the Result Window.
(None/Normal/Detail)
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Check Derivative
Replace Dud Pixels...
Trend Subtract

Extract Images
Extract Current Slice

Complex To Real P — Phase
Extract Phase image from Project %::I“tucje
Shift Wrapped Phase... I_maginary
Reactivate Reference Point Intensity

The menus of the Ultilities are described below.

Menu

Description

Check Derivative

Displays an intensity derivative along the propagation direction.
This command is useful to check an image alignment. You can
use this command for the aligned project.

Replace Dud Pixels

A dialog asking a tolerance will be open, and bad (defect) pixel
values determined with this tolerance will be replaced. This
routine will work for the whole image or a selected image area.

Trend Subtract

Subtracts a trend (slowly varying feature) from the front image,
and displays the result in the new image window. This
command is useful to enhance the image feature.

Extract Images

Extracts all the component images from a project.

Extract Current Slice

Extracts one currently displayed image from a project.

Complex to Real

Converts a complex image to a real image type selected from
Phase/Amplitude/Real/Imaginary/Intensity).

Extract Phase Image
from Project

This command extracts the phase image from the project
image, for which the phase has been evaluated.

Shift Wrapped Phase...

Phase value will be shifted (added/subtracted) by a specified
value (in radians).

Reactivate Reference
Points

This command reactivates the handler for the reference
points. Thus, the reference points become active when you
change the displayed slice.

NOTE: When you close the project image and re-open it, you
can see the reference points (Mouse points or Line
Annotation) only on the displayed image, even when the
reference points exist on each image of the project. Namely,
the reference points do not move when the displayed slice is
changed. This is because the handler for reference points is
terminated when the image is closed.
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